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© Copyright Avril 2020 par VIDAR Systems Corporation. Tous droits réservés. 
 
Aucune partie du présent document ne peut être reproduite, stockée dans un système d'extraction 
ou transmise, sous quelque forme ou par quelque moyen que ce soit (électronique, mécanique, par 
photocopie, sous forme enregistrée ou autre), sans l'autorisation écrite préalable de VIDAR Systems 
Corporation. 
 
ClinicalExpress est une marque déposée de VIDAR Systems Corporation. 
 

VIDAR® fournira une assistance conformément aux modalités énoncées dans l'accord de 
licence. D'autres modalités peuvent avoir été présentées par des revendeurs VIDAR. Si ces 
modalités diffèrent de celles offertes par VIDAR, le revendeur, et non VIDAR, est tenu de 
s'acquitter de ces obligations. En outre, une assistance sera accordée uniquement dans les 
situations suivantes : 

 L'installation et les modifications sont réalisées par un personnel qualifié. 

 L'équipement est utilisé conformément aux instructions de ce manuel. 

 Aucun logiciel ou équipement autre que ceux sélectionnés par VIDAR ou distribués par 
VIDAR pour ClinicalExpress ne doit être utilisé sur la station de travail ClinicalExpress. 
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Assistance technique : 
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(États-Unis uniquement) 
E-mail : medtech@3Dsystems.com 

 

Emergo Europe 
Prinsessegracht 20 
2514 AP, La Haye  
Pays-Bas 
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Utilisation Conforme 
 

 
 
 

 
Utilisation conforme 
 
ClinicalExpress est conçu pour transmettre une image DICOM d'un numériseur d'images médicales à un 
fournisseur de classe de service DICOM pour l'impression ou le stockage. La population visée se compose des 
utilisateurs souhaitant utiliser un numériseur radiologique pour numériser des films analogiques ou 
transmissifs sur une station de travail DICOM en utilisant une approche classique de téléradiologie et des 
utilisateurs qui souhaitent dupliquer des clichés imprimés en utilisant la technologie numérique des protocoles 
DICOM et postscript. 

 
 
Utilisateur prévu 
 
Les utilisateurs cibles de ces appareils sont des professionnels de la santé ou du personnel qualifié à 
utiliser comme images de capture secondaires pour consultation, examen et interprétation finale. 
 
Il n'y a aucune exigence de formation pour l'utilisateur. L'utilisateur doit être familiarisé avec la 
manipulation de films radiographiques et l'utilisation d'équipements de bureau tels qu'un ordinateur. 
L'utilisateur doit lire le guide de l'utilisateur pour comprendre comment charger des films dans le 
numériseur de films. L'utilisateur devra se familiariser avec le logiciel utilisé sur le PC pour acquérir 
l'image numérisée 

 
 
Avis à l'utilisateur 
 

• Il n'y a aucun avertissement ou précaution. L'appareil n'est pas en contact avec le patient. Aucune 
contre-indication ou précaution n'est requise. 

 
 En cas d'incident grave lié à l'appareil, veuillez en informer le fabricant et l'autorité compétente 

de l'État membre dans lequel l'utilisateur et / ou le patient sont établis. 
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Sécurité et performance, 
Stockage et manutention 

 

 
Sécurité et performance 
 
• Puisqu'il s'agit d'un logiciel installé sur un PC Windows hôte, il n'y a aucun problème de sécurité avec le 
produit. Les performances du produit sont contrôlées par la sortie de l'appareil fournissant les données et 
par la formation et les connaissances de l'utilisateur. 
 
• Il est prévu que l'utilisateur puisse évaluer et ajuster les images à l'aide des outils du logiciel pour 
maximiser la qualité de l'image avant d'être envoyé au PACS. 
 
Stockage et manutention 
 
• Tenez les disques par le bord extérieur ou le trou central. 
• Gardez la saleté ou d'autres corps étrangers du disque. 
• Rangez les disques en position verticale (style livre) dans des étuis en plastique fournis avec le CD 
• Remettez les disques dans des étuis de rangement immédiatement après leur utilisation. 
 
• Le CD du logiciel ClinicalExpress doit être stocké dans un endroit sûr par la personne responsable du 
poste de travail logiciel. Le CD sera nécessaire si le PC est. 
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À propos de ce manuel 

 
 

Ce manuel fournit des instructions détaillées sur l'installation et l'utilisation de 
ClinicalExpress®. Il aborde les sujets suivants : 
 

 Le chapitre À propos de ClinicalExpress décrit ClinicalExpress en tant 
que partie intégrante d'un système DICOM classique de radiographie ou de 
mammographie. 

 

 Le chapitre Installation de ClinicalExpress passe en revue les exigences 
du système et fournit des instructions pour l'installation du logiciel. 

 

Remarque - Consultez la déclaration de conformité DICOM 
fournie séparément pour obtenir des informations sur la 
connectivité. 

 

 Le chapitre Configuration de ClinicalExpress indique comment configurer 
les systèmes d'acquisition et de transmission de films ClinicalExpress, et traite 
d'autres sujets d'intérêt pour les gestionnaires de systèmes ClinicalExpress. 

 

Remarque - Des instructions d'utilisation sont fournies dans un 
autre manuel, le « Guide de l'opérateur ClinicalExpress ». 

 
 

Conventions utilisées dans ce manuel 
 

 Les touches spéciales sur lesquelles vous devez appuyer sur le clavier sont 
indiquées par des PETITES MAJUSCULES. Par exemple, lorsque vous lisez le mot 
ENTRÉE dans le texte, appuyez sur la touche correspondante de votre clavier. 

 

 Les noms de menus et les commandes de menu s'affichent en lettres majuscules. 
Par exemple, le menu Fichier (File) contient la commande Installer la licence 
(Install License). Dans ce manuel, les commandes sont indiquées par une formule 
abrégée. Par exemple, Fichier > Quitter (File > Exit), signifie sélectionnez la 
commande Quitter (Exit) dans le menu Fichier (File). 

 

 Le nom des fenêtres, boutons, boîtes de dialogue et autres fonctionnalités à l'écran 
est en caractères gras. Par exemple, la fenêtre de connexion à ClinicalExpress 
(ClinicalExpress Login) (ci-dessous) comporte les champs Nom d'utilisateur 
(User Name) et Mot de passe (Password), ainsi que des boutons libellés OK et 
Annuler (Cancel). 
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À propos de ClinicalExpress®
 

 

 
 
 
ClinicalExpress 6.0 est un programme Windows qui numérise les films et 
transmet les images de films. Le programme intègre des modes de radiographie 
générale de mammographie, et peut être acheté pour la radiographie générale 
uniquement, pour la mammographie uniquement, ou pour les deux modes. 
 
Numérisation. En utilisant un numériseur de films VIDAR comme entrée, 
ClinicalExpress affiche les images de clichés et les associe à un patient et à un 
examen. Le programme fournit un ensemble de commandes permettant de 
contrôler la qualité d'une image et d'ajuster ses caractéristiques. 
 
Indications d'emploi. Les clichés de radiologie générale numérisés à l'aide de 
ClinicalExpress correspondent ou surpassent les normes DICOM et de l'ACR 
relatives à l'utilisation des images numérisées une deuxième fois à des fins de 
consultation, d'examen et d'interprétation finale. 

 
Les images de mammographie numérisées à l'aide de ClinicalExpress en tant que 
MG DICOM sont destinées à être utilisées à titre de référence ou de comparaison 
uniquement, pas pour un premier diagnostic. 
 
 
 
Options 
 
Ces options peuvent être achetées séparément : 
 
Liste de travail des modalités. Cette option permet à des modalités d'imagerie 
de télécharger des informations de listes de travail concernant des procédures 
programmées ainsi que les données qui s'y rapportent, de présenter ces informations 
à l'utilisateur de la modalité et de s'assurer que les images DICOM contiennent des 
données descriptives cohérentes. Des instructions concernant l'utilisation de cette 
liste de travail des modalités de ClinicalExpress sont fournies dans ce manuel. Les 
détails relatifs à l'intégration sont fournis dans la Déclaration de conformité DICOM. 
 
PDI. Cette option comprend les fonctionnalités d'importation/exportation de 
support DICOM (permettant de lire et d'écrire des CD compatibles DICOM), 
de numérisation à plat de documents, de recherche de patients (pour rechercher 
des informations sur les patients sur des périphériques de stockage). 
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Présentation du système 
 

Une station de travail ClinicalExpress classique de numérisation et de 
transmission de films est composée des éléments suivants : 
 

 numériseur de films VIDAR afin de créer des images numériques à partir 
de films ; 

 

 ordinateur Windows® XP 32 bits ou Windows 7 32 ou 64 bits exécutant 
le programme ClinicalExpress. 

 
 

Remarques 

 La station de travail ClinicalExpress n'est PAS une station de 
diagnostic. Pour les tâches de diagnostic, utilisez une station de 
travail appropriée (consultez le guide d'installation et d'utilisation 
de la station de diagnostic pour obtenir des instructions). 

 Les images de mammographie numérisées à l'aide de 
ClinicalExpress doivent être utilisées à titre de référence ou 
à des fins de consultation uniquement. Elles ne doivent pas 
être utilisées pour un diagnostic principal. 

 
 
 

Mode Radiographie générale (General Radiography) 
 

Pour la transmission des images, la station de travail utilise une connexion de 
données, qui délivre les données d'images à une station de travail ou un système 
à distance. Pour les copies, la station de travail se branche sur un reprographe 
de films ou un périphérique de sortie non destiné aux films. Une entrée 
supplémentaire peut être fournie par un scanner de documents en option. 
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Mode Mammographie (Mammography) 
 
Pour la transmission des images, la station de travail utilise une connexion de 
données, qui délivre les données d'images à une station de travail ou un système 
à distance. 
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Possibilités offertes par ClinicalExpress 
 
ClinicalExpress 6.0 est votre premier point de contrôle pour l'acquisition, la 
transmission et la copie de films. Le programme vous permet de : 

 Numériser 
 Désignez un patient et un examen, ou créez un nouveau dossier de patient 

et/ou un nouvel examen. 
 Utilisez l'option de liste de travail des modalités (disponible séparément) 

pour extraire des informations sur le patient à partir d'une source externe 
(au lieu de taper les données patient). 

 Définissez les paramètres de base de la numérisation : profondeur de bits 
et résolution. 

 Numérisez un ou plusieurs films. 
 Effectuez un contrôle qualité de l'image créée à partir du film avant son 

envoi ou sa copie. 
 Manipulez l'image : pour définir la luminosité et le contraste, faire pivoter, 

retourner, inverser les valeurs de teintes, diviser des images, agrandir une 
région d'intérêt, zoomer, et retoucher des informations sensibles. 

 Transmettre 
 Sélectionnez une station de travail ou un système à distance (la « cible »). 
 Envoyez les images numérisées à la cible sélectionnée. 
 Numérisez et envoyez en une seule opération. 

 Copier (uniquement en mode de radiographie générale) 
 Sélectionnez une imprimante (si plusieurs imprimantes sont raccordées 

au système). 
 Définissez le nombre de copies à effectuer pour chaque cliché d'origine. 
 Lancez l'impression. 
 Combinez plusieurs images en un film. 
 Numérisez et imprimez en une seule opération. 

 Importer et exporter depuis/vers des CD compatibles DICOM 
 
ClinicalExpress est concédé sous licence sur la base de ses fonctionnalités/fonctions. 
Toutes les licences incluent la fonction de numérisation ainsi que la technologie 
DICOM Send (envoi aux fournisseurs de classes de service DICOM, stations 
de travail/PACS) et Copy (impression sur des reprographes DICOM et/ou des 
périphériques compatibles Postscript). En outre, vous pouvez acheter des licences 
pour : 

 Liste de travail des modalités. 

 PDI. Gravure de CD à partir de la visionneuse DICOM pour l'exportation 
du support, l'importation/exportation de support, la recherche de patient et 
scanner de documents papier. 
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Nouvelles fonctionnalités de ClinicalExpress 6.1 
 
 Nouvelles options format de date. 
 Prise en charge de balises DICOM dérivées de la mammographie/primaires 

pour la compatibilité avec les sites GE. 
 Prise en charge de l'acquisition de date de balise de mammographie pour la 

compatibilité avec les sites Siemens. 
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Installation de ClinicalExpress®
 

 

 
 

Configuration système requise 
 
Pour numériser et transmettre des images à l'aide de ClinicalExpress®, vous 
devrez fournir un système informatique, un numériseur de films VIDAR et une 
connexion réseau. 
 
 
Ordinateur 
 
La configuration système minimale pour Windows XP 32 bits SP3 est la suivante : 
 Ordinateur équipé d'un processeur Pentium 4 de 3 GHz  
 2 Go de mémoire ; les longues séries d'images haute résolution, comme celles 

de mammographies, nécessitent plus de mémoire. 
 50 Go d'espace libre sur le disque dur 
 
La configuration système minimale pour Windows 7 Professionnel 32 bits et 
64 bits est la suivante : 
 Ordinateur équipé d'un processeur Pentium Dual Core 2 de 1,8 GHz 
 4 Go de mémoire ; les longues séries d'images haute résolution, comme celles 

de mammographies, nécessitent plus de mémoire. 
 50 Go d'espace libre sur le disque dur 
 
Vidéo pour tous les ordinateurs : 
 Carte vidéo avec 16 Mo de mémoire, réglée sur une résolution de 1280 x 1024, 

64 000 couleurs ou plus 
 Écran 20 pouces avec une résolution de 1280 x 1024 
 
 
Numériseur de films 
 
ClinicalExpress fonctionne avec la plupart des numériseurs de films médicaux 
VIDAR. Contactez Medtech à l'adresse medtech@3dsystems.com pour 
déterminer si votre numériseur est compatible. 
 
ClinicalExpress ne fonctionne pas avec les numériseurs de films fabriqués par 
d'autres fabricants. 
 
 
Connexion réseau 
 
Les connexions réseau incluent, sans toutefois s'y limiter les réseaux LAN, WAN, 
sans fil et divers services téléphoniques. Le protocole TCP/IP est requis pour un 
fonctionnement correct. Les détails de la connexion réseau n'entrent pas dans le 
champ d'application de ce manuel. 
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Scanner de documents en option 
 
Vous pouvez ajouter un scanner de documents à interface USB à votre système. 
ClinicalExpress fonctionne avec la plupart des pilotes TWAIN. La possibilité 
d'utiliser un scanner de documents est une option qui s'achète. Contactez l'assistance 
technique de VIDAR (cf. ci-dessous) pour obtenir une liste des scanners testés. 
 
 

Scénarios d'installation 
 
Examinez les scénarios ci-dessous pour déterminer votre statut actuel, et la 
manière dont vous devez effectuer l'installation de ClinicalExpress 6.0. 
 
 
 Si vous installez ClinicalExpress pour la première fois : 

1. Exécutez le fichier ClinicalExpress6.x.exe qui se trouve sur le CD 
ClinicalExpress. 

2. Le logiciel s'exécute en mode d'évaluation de 30 jours. Pour utiliser le logiciel 
au-delà de 30 jours, vous devrez acheter une clé de licence (reportez-vous à la 
section « Obtention d'une clé de licence ClinicalExpress » plus loin dans le 
présent chapitre). 

 
 
 Si une version antérieure de ClinicalExpress est actuellement installée : 

 Pour les versions 4.x et les versions antérieures installées, contactez 
l'assistance technique de VIDAR (cf. ci-dessous) pour obtenir des instructions. 

 Pour la version 5.0 et les versions ultérieures installées, vous pouvez 
installer ClinicalExpress 6.0 sans désinstaller la version précédente. 

 
 
 

Contactez l'assistance technique de VIDAR si vous avez des 
questions sur l'installation du logiciel ClinicalExpress : 

Téléphone : +1.800.471.SCAN (+1.800.471.7226) 

                    +1.703.471.7070 en dehors des États-Unis 

E-mail :        medtech@3dsystems.com 
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Présentation de l'installation 

 
Remarque - Vous devez être connecté en tant qu'administrateur pour 
installer ClinicalExpress et exécuter des fonctions d'administrateur. Les 
utilisateurs peuvent avoir, mais ne nécessite pas de droits 
d'administration sur le PC. Pour obtenir des instructions, consultez : 
 la rubrique « Ajouter un membre à un groupe » dans le Centre d'aide 

et d'assistance de Windows XP ; 
 les rubriques « Créer un nouveau compte utilisateur » et « Modifier un 

compte utilisateur » dans le fichier d'aide relatif à la fenêtre de gestion 
de l'ordinateur Windows. 

 
L'installation implique les cinq étapes générales suivantes : 

A. Installation et configuration du numériseur de films 

B. Configuration de l'affichage 

C. Installation du logiciel ClinicalExpress 

D. Lancement de ClinicalExpress 

E. Obtention d'une clé de licence ClinicalExpress 

 
Des détails sont fournis dans les sections suivantes. 
 

Conseil - Si vous êtes en train d'installer un nouvelle station 
de travail, n'installez pas tous les composants en même temps. 
Au lieu de cela, installez d'abord le numériseur de films 
(conformément aux instructions fournies avec le numériseur). 
Ensuite, réglez l'affichage (étape B). Pour finir, installez le 
logiciel ClinicalExpress (étape C), et assurez-vous que le 
système fonctionne. 

 
 
 

A. Installation et configuration du numériseur de films 
 
Installez et configurez le numériseur de films et son logiciel, conformément aux 
instructions fournies avec le numériseur (les détails n'entrent pas dans le champ 
d'application de ce manuel). 
 
 

Remarque - Vous pouvez télécharger les guides d'installation 
et d'utilisation du numériseur de films VIDAR à la rubrique 
Assistance clientèle sur www.filmdigitizer.com. Vous pouvez 
également demander les manuels en appelant le +1.800.471.7226 
(+1.703.471.7070 en dehors des États-Unis). 
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B. Configuration de l'affichage 
 
1. Effectuez un clic droit sur le bureau, puis cliquez sur Propriétés (Properties) 

dans le menu contextuel. 
 

  
 

Remarque - Sur votre système, une commande spécifique de 
la carte vidéo peut être remplacée par la commande Propriétés 
(Properties). Dans ce cas, cliquez sur cette commande. La boîte 
de dialogue Propriétés d'affichage (display properties) peut être 
différente, mais l'objectif est le même : réglez la résolution 
d'affichage sur 1280 x 1024 ou plus, et réglez la profondeur 
d'échantillonnage sur 16 bits ou plus. 

 
2. Dans la fenêtre Propriétés d'affichage (Display Properties), cliquez sur 

l'onglet Paramètres (Settings). 
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3. Réglez la zone d'écran (Screen Area) (ou la résolution d'écran [Screen 
Resolution]) sur 1280 par 1024 ou plus, et réglez les couleurs (ou la qualité 
de la couleur) sur Haute Définition (16 bits) ou plus. 

 

  
 
4. Cliquez sur OK. 
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C. Installation du logiciel ClinicalExpress 
 

Remarque - Si vous effectuez une mise à niveau à partir de 
ClinicalExpress 4.x ou d'une version antérieure, contactez 
l'assistance technique de VIDAR à l'adresse 
medtech@3dsystems.com pour obtenir des instructions. 

 
Remarque - Vous pouvez installer ClinicalExpress en l'absence 
de numériseur de films dans le système. Toutefois, ClinicalExpress 
ne fonctionnera que si le numériseur de films est raccordé à 
l'ordinateur, est sous tension et communique avec l'ordinateur. 

 

1. Insérez le CD ClinicalExpress dans le lecteur de CD-ROM de votre ordinateur. 
 
2. Dans l'Explorateur Windows, accédez au lecteur de CD-ROM, puis double-

cliquez sur ClinicalExpress6.x.exe. 
 
3. Suivez les instructions fournies dans les fenêtres du programme d'installation. 
 
 Au cours de l'installation, il vous sera demandé de sélectionner l'interface 

utilisateur par défaut (radiographie générale [Radiography] ou mammographie 
[Mammography]) qui s'affiche au lancement de ClinicalExpress. Sélectionnez 
l'interface utilisateur la plus appropriée pour votre établissement (ce choix 
peut être modifié dans la page ClinicalExpress Administration > Locale 
[Administration > Local]). 

 
4. Une fois l'installation terminée, retirez le CD du lecteur de CD-ROM. 

(Vous aurez besoin de la clé de CD figurant sur l'étiquette du CD à l'étape E.) 
 
 
 
 

Ajout d'un scanner de documents à plat 
 
Vous pouvez installer un scanner de documents à plat à utiliser avec ClinicalExpress. 
Suivez les instructions d'installation du fabricant du scanner. VIDAR a testé des 
scanners classiques à interface USB 2.0 dotés de pilotes TWAIN, et a conclu qu'ils 
étaient compatibles avec ClinicalExpress. 
 

Remarque - Seul le pilote TWAIN de scanner à plat doit être 
installé sur la station de travail ClinicalExpress. La présence 
de tous autres pilotes TWAIN risque d'interférer avec le 
fonctionnement de ClinicalExpress. Contactez l'assistance 
technique de VIDAR à l'adresse medtech@3dsystems.com 
pour obtenir une liste des scanners testés. 
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D. Lancement de ClinicalExpress 
 

Remarque - ClinicalExpress fonctionne pendant 30 jours sans 
clé de licence. Pour continuer à utiliser ClinicalExpress au-delà 
de cette période, contactez VIDAR Systems Corporation pour 
obtenir une clé de licence (des instructions sont fournies dans 
la section suivante). 

 
1. Double-cliquez sur l'icône ClinicalExpress située sur le bureau.  
  ou 
 Démarrer > Tous les programmes > ClinicalExpress  

(Start > All Programs > ClinicalExpress). 
 
2. La fenêtre Connexion utilisateur (User Login) s'affiche. 
 

  
 
3. Utilisez le nom/mot de passe par défaut de l'administrateur : 

a. Laissez Admin comme nom d'utilisateur (User Name). 
b. Laissez le champ du Mot de passe (Password) vide. 
c. Cliquez sur OK. 

 
4. Si le numériseur est sous tension et correctement raccordé, le message ci-

dessous s'affiche. Cliquez sur OK. 
 

  
 
5. ClinicalExpress démarre. 
 

Remarque - Vous ne pouvez pas numériser de films tant que 
que vous n'avez pas défini au moins une cible valide. Reportez-
vous au chapitre suivant de ce manuel intitulé « Configuration 
de ClinicalExpress ». 
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E. Obtention d'une clé de licence ClinicalExpress 
 

Remarque - Vous ne pouvez pas obtenir une clé de licence en 
faxant l'accord de licence de ClinicalExpress. Vous devez suivre 
les instructions de cette section pour obtenir une clé de licence 
par courrier électronique. 

 
Procédez comme suit pour obtenir une clé de licence : 
 
1. Générez un code de référence et envoyez-le à VIDAR : 
 

Remarque - Vous pouvez générer un code de référence 
uniquement si l'ordinateur Clinical-Express est raccordé à un 
numériseur de films VIDAR. 

 
a. Dans la fenêtre principale de ClinicalExpress, Fichier > Générer un code 

de référence (File > Generate Reference Code). 
 
b. Dans la boîte de dialogue Générer un code de référence (Generate 

Reference Code) : 
 Entrez ou modifiez le nom d'utilisateur (User Name), l'entreprise 

(Company) et le pays (Country). 
 Entrez la clé de CD (CD Key) inscrite sur l'étiquette du CD 

d'installation de ClinicalExpress. 
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c. Cliquez sur le bouton Générer un code de référence (Generate Reference 
Code). 

 

  
 

Remarque - Le code de référence est valide pendant 15 jours. 

 
d. Cliquez sur le bouton Enregistrer (Save) pour enregistrer le code de 

référence sous forme de fichier sur le disque dur local. Enregistrez le 
fichier à un emplacement que vous pouvez facilement mémoriser. 

 
e. Cliquez sur le bouton Fermer (Close). 
 
f. Rédigez un nouveau message électronique. 
 
g. Dans le champ À (To) du message, entrez l'adresse 

medtech@3dsystems.com. 
 
h. Puis : 
 
 Localisez le fichier (il comportera l'extension .ref) que vous avez 

enregistré à l'étape d ci-dessus et joignez-le au message. 
 
i. Envoyez le message : 
 

Remarque - En attendant votre clé de licence, vous pouvez utiliser 
ClinicalExpress en mode d'évaluation sans clé pendant un 
maximum de 30 jours. Toutes les fonctionnalités sont activées 
pendant la période d'essai de 30 jours. 
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2. Une fois que vous avez reçu votre clé de licence par courrier électronique de 
la part de VIDAR : 

 
a. Enregistrez la pièce jointe (comportant l'extension .key) sur votre bureau. 
 
b. Connectez-vous à ClinicalExpress en tant qu'administrateur. 
 
c. Dans la fenêtre principale de ClinicalExpress, Fichier > Installer la 

licence (File > Install License). 
 

  
 
d. Dans la boîte de dialogue Installer la licence (Install License) : 
 
 Cliquez sur le bouton Charger à partir du fichier (Load From File), 

puis localisez le fichier de clé de licence (comportant l'extension .key) 
et ouvrez-le. 

 

  
 
e. Cliquez sur le bouton Enregistrer (Register). 
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f. Si la clé de licence est acceptée, la fenêtre ci-dessous s'affiche.  
Cliquez sur OK. 

 

  
 
g. Fichier > Quitter (File > Exit). 
 
h. Lancez de nouveau ClinicalExpress en double-cliquant sur l'icône 

ClinicalExpress située sur le bureau. 
 
i. Pour vérifier votre licence : Aide > À propos (Help > About). Votre 

licence sera en haut de la page. Si vous disposez d'une licence pour la 
radiographie générale et la mammographie, vous devez effectuer cette 
vérification dans les deux applications. 

 
3. Pour configurer le programme, passez à la section suivante de ce manuel qui 

est intitulée « Configuration de ClinicalExpress ». 
  ou 
 Si vous avez besoin de configurer ClinicalExpress pour l'impression, veuillez 

consulter les instructions de configuration des imprimantes validées pour une 
utilisation avec ClinicalExpress dans le répertoire Spécifique de l'imprimante 
(Printer Specific) sur le CD d'installation de ClinicalExpress. 
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Configuration de 
ClinicalExpress®

 

 
 
 

Introduction 
 
Ce chapitre décrit les opérations qui peuvent être effectuées par l'administrateur 
dans ClinicalExpress : 

 Connexion à la fenêtre Administration 

 Réglage des paramètres de la station de travail locale 

 Réglage des paramètres d'affichage 

 Réglage des résolutions du numériseur 

 Paramétrage des options de traitement d'images 

 Définition de vues pour la mammographie 

 Désignation de champs obligatoires de saisie de données 

 Gestion de comptes utilisateurs 

 Sélection de champs de données pour l'anonymisation 

 Sauvegarde et restauration de la licence 

 Définition de cibles 

 Examen de la configuration du numériseur de films 

 Vérification de la disponibilité de la liste de travail des modalités 

 Examen et gestion du fichier journal 

 Étalonnage du numériseur de films 
 
En outre, ce chapitre fournit des instructions basiques pour l'étalonnage de 
ClinicalExpress. 
 
Si vous configurez ClinicalExpress pour la première fois, vous devez suivre toutes 
les sections de ce chapitre et effectuer toutes les opérations qui s'appliquent aux 
fonctions de votre licence ClinicalExpress et à la configuration de votre système. 
 

Remarque - Vous devez être connecté en tant qu'administrateur 
de l'ordinateur local pour pouvoir accéder à la fenêtre 
Administration de ClinicalExpress et y apporter des modifications. 

 

Remarque - Vous ne pouvez pas numériser de films tant que 
que vous n'avez pas défini au moins une cible valide. Reportez-
vous à la section « Définition de cibles » ultérieurement dans le 
présent chapitre. 
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Connexion à la fenêtre Administration 
 
Le mot de passe de la fenêtre Administration est protégé. 
 
1. Options > Administration. 
 
 Si vous êtes déjà connecté à ClinicalExpress en tant qu'administrateur, vous 

verrez la fenêtre Administration et pouvez ignorer l'étape 2. Sinon, vous 
verrez la fenêtre de connexion : 

 

  
 
2. Entrez le mot de passe (Password) de l'administrateur, puis cliquez sur OK. 
 
 
 

Conseil - Le nom par défaut 
est Admin (sensible à la casse) 
et le mot de passe par défaut 
est l'absence de mot de passe 
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Réglage des paramètres de la station de travail locale 
 
Définissez les paramètres de la station de travail locale dans la branche Locale de 
l'arborescence Administration. 
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Paramètres DICOM 
 

 
 
 
Le titre AE (Application Entity) est le nom que d'autres applications logicielles 
utilisent pour identifier cette application. 
 
1. Entrez le titre AE de ce dispositif DICOM (par défaut, « ClinicalExpress » est 

saisi dans ce champ). Le titre AE est sensible à la casse. 
 
2. Entrez le numéro de port (Port Number) de ce dispositif DICOM (par défaut, 

« 207 » est saisi dans ce champ). 
 
3. Cliquez sur le bouton Appliquer (Apply). 
 
 
Journal 
 

 
 
 
1. Modifiez les paramètres de journal selon vos besoins : 
 
 Niveau de journal (Log Level) : indique les types d'informations visibles 

dans la fenêtre du journal d'erreurs (Error Log). 
 INFORMATIONS (INFORMATION) affiche les informations DICOM 

et les informations de ClinicalExpress. 
 AVERTISSEMENT (WARNING) affiche les erreurs et les avertissements 

uniquement. 
 ERREUR (ERROR) affiche les erreurs uniquement. 

 
 ClinicalExpress saisit automatiquement toutes les erreurs et informations. 

(Pour afficher l'intégralité du journal d'erreurs, ouvrez le fichier clx.log 
dans un éditeur de texte.) 

 
Remarque - La fenêtre Journal d'erreurs (Error Log) n'est pas 
un outil de diagnostic DICOM complet, car elle ne saisit pas 
l'ensemble des transmissions DICOM. Elle sert principalement 
à la résolution des problèmes du logiciel. 
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 Conserver les entrées du journal (Keep Log Entries) : les entrées du 
fichier journal seront supprimées après ce nombre de jours. (Reportez-vous 
à la section « Examen et gestion du fichier journal » ultérieurement dans le 
présent chapitre.) 

 
2. Cliquez sur le bouton Appliquer (Apply). 

 
 

Localisation 
 

 
 
1. Sélectionnez la langue (Language) qui sera utilisée dans l'interface utilisateur 

de l'application. 
 
2. Sélectionnez le format de date (Date Format) à utiliser dans l'application. 
 
3. Cliquez sur le bouton Appliquer (Apply). 
 
4 Quittez ClinicalExpress et relancez l'application pour appliquer la modification. 
 
 
Système 
 

 
 
 
1. Modifiez les paramètres selon vos besoins (les paramètres par défaut sont 

indiqués ci-dessus) : 
 
 Espace disque minimum (Minimum Disk Space) : lorsque l'espace disque 

libre est inférieur à cette valeur, ClinicalExpress supprime automatiquement 
des fichiers, en commençant par les examens les plus anciens qui ont été 
transmis avec succès. Si le programme ne parvient pas à libérer suffisamment 
d'espace disque pour atteindre la valeur d'Espace disque minimum 
(Minimum Disk Space), il empêche l'utilisateur de numériser des films jusqu'à 
ce qu'une quantité suffisante d'espace soit libérée. 
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 Longueur maximale de film (Maximum Film Length) : cette valeur, 

normalement réglée pour une longueur de film de 17 pouces, peut être 
modifiée pour accueillir des films plus longs. 

 
Remarque - Augmentez la longueur maximale de film (Max Film 
Length) à une valeur supérieure à 17 pouces uniquement si un 
numériseur de films DIAGNOSTICPRO® Plus ou DIAGNOSTICPRO® 
Advantage est raccordé. Reportez-vous au guide d'utilisation du 
numériseur de films correspondant pour plus d'informations sur la 
numérisation de films d'une longueur supérieure à 17 pouces. 

 

Remarque - Étant donné que le système utilise une routine de 
dimensionnement automatique pour déterminer la longueur de 
film, la numérisation des films perforés risque de ne pas être 
possible. 

 
 Nouvelles tentatives de transmission (Transmission Retries) : définit le 

nombre de fois que ClinicalExpress va tenter d'envoyer un examen à une 
cible. ClinicalExpress traite les tentatives infructueuses de transmission 
d'examens comme suit : 
 Si d'autres examens se trouvent dans la file d'attente de transmission, un 

examen dont la transmission a échoué est placé à la fin de la file d'attente 
et une tentative sera faite pour envoyer l'examen ultérieurement - opération 
soumise au nombre de nouvelles tentatives de transmission et à un délai 
d'attente (cf. ci-dessous). 

 En l'absence d'autres examens dans la file d'attente de transmission, 
ClinicalExpress tente immédiatement de renvoyer l'examen - opération 
soumise au nombre de nouvelles tentatives de transmission et à un délai 
d'attente (cf. ci-dessous). 

 Si l'examen ne peut pas être envoyé après le nombre défini de tentatives de 
transmission, il est répertorié dans la fenêtre Examens acquis (Acquired 
Studies)(Affichage > Examens acquis [View > Acquired Studies]), depuis 
laquelle vous pouvez lancer la transmission manuellement. 

 Un examen qui ne peut pas être envoyé aura un statut d'« échec » jusqu'à ce 
qu'il soit envoyé. 

 
 Délai de tentative (Retry Time) : définit la durée (en minutes) que 

ClinicalExpress doit attendre avant de tenter d'envoyer un examen à une 
cible si la tentative précédente a échoué. 

 
 Champ de début de listes (Lists’ Start Field) : contrôle si le nom du 

patient (Patient Name) ou son ID est la première colonne dans la liste 
des examens acquis et la liste de travail Liste des procédures. 

 
 Chemin des images (Images Path) : si vous le souhaitez, modifiez le 

répertoire de stockage par défaut de l'image locale. Faites-le, par exemple, si 
vous souhaitez stocker les images sur un disque ou une partition d'une plus 
grande capacité. Pour modifier le chemin, puis cliquez sur le bouton ..., puis 
sélectionnez un nouveau chemin. 
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 Touches de verrouillage (Lock Keys) : lorsqu'elles sont activées, 
ClinicalExpress désactive les clés (p. ex., ALT-TAB) qui permettrait à un 
utilisateur de basculer entre ClinicalExpress et d'autres programmes ouverts. 

 
 Activer les antécédents supplémentaires du patient (Enable Additional 

Patient’s History) : lorsque cette option est activée, ClinicalExpress affiche le 
champ Antécédents supplémentaires du patient (Additional Patient History) 
en bas de la fenêtre Informations sur l'examen (Study Information). 

 

  
Fenêtre Informations sur le patient/l'examen/la série 
(Patient/Study/Series Information) sans les antécédents 
supplémentaires du patient (Additional Patient History) 

Fenêtre Informations sur le patient/l'examen/la série 
(Patient/Study/Series Information) avec les antécédents 
supplémentaires du patient (Additional Patient History) 

 

 Générer automatiquement un numéro d'enregistrement (Auto Generate 
Accession Number) : lorsque cette option est activée, ClinicalExpress 
insère automatiquement le numéro d'enregistrement suivant dans la fenêtre 
Informations sur l'examen (Study Information) quand l'utilisateur lance 
un nouvel examen. Le numéro d'enregistrement inséré peut être modifié. 

 
 Envoyer un numéro d'enregistrement vide (Send Empty Accession 

Number) : lorsque cette option est activée, ClinicalExpress n'envoie pas les 
numéros d'enregistrement aux cibles. 

 
 Envoyer l'ID de taille de film (Send Film Size ID) : lorsque option est 

activée, ClinicalExpress envoie les dimensions du film aux cibles. 
 
 Envoyer chaque image en tant que série (Send each image as a Series) : 

lorsque cette option est activée, chaque image est envoyée en tant que 
série. Lorsqu'elle est désactivée, une série peut inclure plusieurs images. 

 
 Définir le type d'image sur DÉRIVÉ\PRIMAIRE (Set Image Type as 

DERIVED\PRIMARY) : lorsque cette option est activée, chaque image est 
balisée pour une utilisation dans les systèmes de mammographie de GE. 

 

2. Cliquez sur le bouton Appliquer (Apply). 
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Déconnexion automatique 
 

 
 
Lorsque cette option (Auto Logout / Déconnexion automatique) est activée, 
ClinicalExpress se ferme automatiquement s'il ne détecte aucune activité de 
l'utilisateur (clavier ou souris) après l'heure indiquée. 
 
Après la modification, cliquez sur le bouton Appliquer (Apply). 
 
 
 
Suppression après envoi 
 

 
 
Lorsque l'option Supprimer après envoi (Delete After Send / Suppression après 
envoi) est activée, ClinicalExpress supprime les patients et/ou les images environ 
10 minutes après qu'ils aient été transmis avec succès à la cible. Points à examiner : 
 Lorsque ces options sont activées, elles contribuent à empêcher que le disque 

de la station de travail n'atteignent sa capacité maximale avec des fichiers 
graphiques. Toutefois, les examens envoyés immédiatement après l'acquisition, 
puis supprimés, ne seront pas répertoriés dans la fenêtre Examens acquis 
(Acquired Studies), et ne peuvent donc pas être envoyés aux mêmes ou aux autres 
objectifs ultérieurement. 

 Lorsque ces options sont activées, elles permettent de répertorier les examens 
dans la fenêtre Examens acquis (Acquired Studies), et de les envoyer à d'autres 
cibles ultérieurement. Toutefois, les examens s'accumulent sur le disque de la 
station de travail et peuvent éventuellement remplir le disque à sa capacité 
maximale. 

 La taille de la base de données ClinicalExpress est limitée à 10 Go. Si elle atteint 
cette limite, vous devez supprimer des images et des patients pour poursuivre la 
numérisation des films. 

 
Après la modification, cliquez sur le bouton Appliquer (Apply). 
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Suppression après engagement de stockage 
 

 
 
Lorsque l'option Supprimer après engagement de stockage (Delete After 
Storage Commitment / Suppression après engagement de stockage) est activée, 
ClinicalExpress supprime les patients et/ou les images uniquement après avoir 
reçu un message d'engagement de stockage de la cible. Ce message confirme que 
la cible a non seulement reçu, mais qu'elle a également mémorisé la transmission. 
(Reportez-vous aux points à examiner de la section ci-dessus intitulée 
« Suppression après envoi ».) 
 
Après la modification, cliquez sur le bouton Appliquer (Apply). 
 
 
 
Démarrage de l'interface utilisateur par défaut 
 

 
 
Cette option (Default Startup GUI) spécifie le mode d'affichage au lancement 
de ClinicalExpress. Si des licences ont été achetées à la fois pour la radiographie 
générale (General Radiography) et la mammographie (Mammography), les 
utilisateurs peuvent basculer entre les modes. 
 
Après la modification, cliquez sur le bouton Appliquer (Apply). 
 
 
 
Remplissage automatique de l'examen 
 

 
 
Lorsque cette option est activée (Auto Fill Study / Remplissage automatique de 
l'examen), la date et/ou l'heure actuelles sont automatiquement entrées dans un 
nouvel examen. 
 
Après la modification, cliquez sur le bouton Appliquer (Apply). 
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Réglage des paramètres d'affichage 
 
Définissez des paramètres d'affichage dans la branche Local | Paramètres 
d'affichage (Local | Display Settings) de l'arborescence Administration. 
 

 

Paramètres d'affichage prédéfinis 
 
Les paramètres d'affichage ajustent automatiquement la luminosité et le contraste 
d'une image, en fonction de la partie du corps et de la modalité sélectionnées par 
l'utilisateur. Les paramètres sont basés sur le type de film, le type de numériseur 
et la profondeur de bits. Quatre paramètres d'affichage prédéfinis sont indiqués 
dans l'écran ci-dessus. Cette section de la fenêtre Administration vous permet 
de définir, modifier et supprimer des paramètres d'affichage. 
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 Pour créer un nouveau paramètre d'affichage : 
 

a. Cliquez sur le bouton Nouveau (New). 
 
b. Cliquez dans le champ Modalité (Modality), puis saisissez la modalité. 
  ou 
 Sélectionnez une modalité existante dans la liste. 
 
c. Cliquez dans le champ Vue (View), puis saisissez la vue. 
  ou 
 Sélectionnez une vue existante dans la liste. 
 
d. Entrez les données de luminosité et de contraste pour une profondeur de 

bits. ClinicalExpress calcule et remplit automatiquement de valeurs 
correspondantes les deux autres profondeurs de bits. 

 

  

Luminosité Contraste 
 

 

Luminosité Contraste 
 
e. Cliquez sur le bouton Enregistrer (Save). 

 
Remarque - ClinicalExpress a des paramètres de luminosité et 
de contraste précalculés pour Partie du corps = VALEUR PAR 
DÉFAUT (Body Part = DEFAULT) et Modalité = VALEUR PAR 
DÉFAUT (Modality = DEFAULT). Ces paramètres sont initialement 
appliqués aux images. L'utilisateur peut remplacer les paramètres 
à l'aide de l'outil de luminosité et de contraste utilisable avec la 
souris, ou en entrant des valeurs dans les champs Luminosité 
(Window) et Contraste (Level) de la fenêtre principale, ou bien 
en utilisant des valeurs prédéfinies de luminosité/contraste. 
L'administrateur peut modifier les paramètres par défaut (listés 
à gauche) comme décrit ci-dessous. 
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 Pour modifier les valeurs de luminosité et de contraste d'un paramètre 
d'affichage : 

 
a. Cliquez sur la ligne que vous souhaitez changer. 
 
b. Cliquez sur le bouton Modifier (Edit). 
 
c. Modifiez les données de luminosité (champ de gauche) et/ou de contraste 

(champ de droite) pour une profondeur de bits. ClinicalExpress calcule et 
remplit automatiquement de valeurs correspondantes les deux autres 
profondeurs de bits. 

 
d. Cliquez sur le bouton Enregistrer (Save). 

 
 
 Pour supprimer un paramètre d'affichage existant : 
 

a. Cliquez sur la ligne que vous souhaitez supprimer. 
 
b. Cliquez sur le bouton Supprimer (Delete). 

 
 
 Pour ajuster automatiquement la luminosité et le contraste selon la taille du 

film et la résolution de l'image : activez l'option Activer la luminosité et le 
automatique automatiques (Enable Auto Window/Level). 
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Réglage des résolutions du numériseur 
 
Définissez les résolutions du numériseur dans la branche Local | Paramètres du 
numériseur (Local | Digitizer Settings) de l'arborescence Administration. 
 

 
 
 
Les paramètres du numériseur règlent automatiquement la résolution de l'image 
en fonction de la largeur du film. 
 
 Pour modifier une résolution : 
 

a. Cliquez sur la ligne contenant la taille de film que vous souhaitez changer. 
 
b. Double-cliquez dans la colonne Résolution (Resolution) de cette ligne. 
 
c. Sélectionnez la résolution souhaitée. 
 
d. Cliquez sur le bouton Enregistrer (Save). 
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Paramétrage des options de traitement d'images 
 
Définissez des options de traitement dans la branche Local | Traitement 
d'images (Local | Image Processing) de l'arborescence Administration. 
 

 
 

Remarque - Les paramètres par défaut dans la fenêtre 
Traitement d'images (Image Processing) sont désactivés. 
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Remarque - ClinicalExpress applique automatiquement et en 
permanence les opérations de traitement d'image sélectionnées 
à chaque image dès son acquisition à partir du numériseur  
(donc, avant qu'elle ne soit affichée ou envoyée). Les utilisateurs 
ne peuvent pas supprimer les résultats du traitement d'image. 
Si des images ne requièrent pas de traitement d'image, 
l'administrateur doit désélectionner les options dans la page 
Traitement d'image (Image Processing), puis l'utilisateur doit 
renumériser les films pour produire de nouvelles images. 

 
1. Paramétrez des options de traitement d'images selon vos besoins : 
 
 Renforcer la netteté (Unsharp Mask) : lorsque cette option est activée, 

ClinicalExpress applique un algorithme de renforcement de la netteté pour 
accentuer les détails de l'image. Sélectionnez Faible (Low), Moyen (Medium) 
ou Élevé (High) pour contrôler le gain de netteté. 

 
 RDC (Dynamic Range Compression, compression de la plage dynamique) : 

lorsque cette option est activée, ClinicalExpress applique un filtre non linéaire 
pour comprimer la plage dynamique. Sélectionnez Faible (Low), Moyen 
(Medium) ou Élevé (High) pour contrôler le gain de compression. 

 
 Traitement post-numérisation (Post-Digitization Processing) : 
 Redresser l'image après la numérisation (Straighten Image After 

Digitization) : lorsque cette option est activée, les images dépassant la 
valeur seuil (Threshold Value) sont automatiquement redressées après 
l'acquisition. Lorsque cette option est désactivée, l'utilisateur peut 
redresser les images dans la fenêtre ClinicalExpress. 

 Valeur seuil (Threshold Value) : l'image doit être pivotée plus que cette 
valeur pour bénéficier du redressement automatique. 

 Réinitialiser (Reset) : cliquez sur ce bouton pour restaurer les valeurs 
seuil par défaut. 

 
Remarque - Le redressement automatique de l'image suppose 
que les bords du film sont droits et à angle droit. Désélectionnez 
cette option si les films ont été tronqués. 

 
 Palette de couleurs du moniteur (Monitor LUT) : lorsque cette option est 

activée, ClinicalExpress applique les valeurs de la palette de couleurs à 
l'image avant son affichage. 
 Depuis le fichier (From File) : sélectionnez cette option si la palette de 

couleurs est disponible sous forme de fichier. Entrez le chemin d'accès 
et le nom du fichier, ou cliquez sur le bouton Parcourir (Browse) pour 
désigner le fichier. 

 Générer à l'aide de la densité (Generate Using Density) : sélectionnez 
cette option pour que ClinicalExpress génère une palette de couleurs 
basée sur la valeur de la densité. 
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 Appliquer les valeurs SDF (Apply SDF) : lorsque cette option est activée, 
ClinicalExpress applique les valeurs standard de fonction d'affichage à l'image 
avant que celle-ci ne s'affiche, à l'aide des valeurs d'illumination, de lumière 
ambiante (Ambient Light), DMin (digitizer’s minimum density, densité 
minimale de numériseur) et DMax (digitizer’s maximum density, densité 
maximale de numériseur). 

 
2. Cliquez sur le bouton Appliquer (Apply). 
 

  

Valeurs DICOM SDF par défaut 

Illumination 2000 cd/m2 

Lumière ambiante 10 cd/m2 

DMin 0 

DMax 255 
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Définition de vues pour la mammographie 
 

Les vues fournissent aux utilisateurs de ClinicalExpress des protocoles de 
présentation permettant l'assemblage de différentes images de mammographie en 
images composites. ClinicalExpress est fourni avec un protocole 2x2 par défaut. 
Vous pouvez définir d'autres vues selon vos besoins. 
 

Remarque - L'option permettant de numériser des documents pour 
la mammographie a été ajoutée à ClinicalExpress 6.0. Si vous ne 
disposez pas de l'option PDI, vous devez l'ajouter pour être en 
mesure de numériser des documents à l'aide d'un scanner à plat. 
Vous devez également définir une mise en page dans laquelle la 
vue de film (Film view) est réglée sur PAPIER (PAPER). 

 

Définissez les vues dans la branche Local | Mammographie  
(Local | Mammography) de l'arborescence Administration. 
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1. Cliquez sur le bouton Nouveau (New). 
 
2. Dans la liste Vues (Views), cliquez dans la colonne Nom (Name), tapez un 

nom de mise en page, puis appuyez sur ENTRÉE (Enter). 
 

 
 
3. Ouvrez la liste Mises en page (Layout), puis cliquez sur la mise en page 

Colonne de la rangée x (row x column) souhaitée. 
 
4. Dans la liste Ordre des vues (View Order), réglez la vue de film (Film View) 

pour chaque cellule. L'aperçu de mise en page indique la manière dont les 
vues de films sont affectées aux cellules. 

 

  
 
 

Remarque - Pour numériser des documents, réglez la vue de 
film (Film View) sur PAPIER (PAPER). 

 
Remarque - L'orientation du patient (Patient Orientation) est 
automatiquement définie lorsque vous sélectionnez une vue de 
film (Film View), et ne doit pas être modifiée. 

 
Remarque - Les utilisateurs peuvent remplacer la valeur par 
défaut de l'orientation du patient (Patient Orientation) définie ici. 

 
 
 Pour supprimer une vue : 

a. Dans la liste Vues (Views), cliquez sur la vue, puis sur le bouton 
Supprimer (Delete). 

b. Confirmez la suppression. 
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 Pour modifier une vue : 
a. Dans la liste Vues (Views), cliquez sur la vue, puis sur le bouton Modifier 

(Edit). 
b. Dans la liste Vues (Views), cliquez sur le Nom (Name), puis saisissez-en 

un nouveau. 
c. Dans la liste Ordre des vues (View Order), modifiez la vue de film (Film 

view) et l'orientation du patient (Patient Orientation), selon vos besoins. 
d. Cliquez sur le bouton Enregistrer (Save). 

 
Remarque - Une vue peut être supprimée ou modifiée 
uniquement si elle ne fait pas référence à un examen. 

 
 
Compréhension des vues et orientations du patient 
 
L'exemple suivant montre les relations entre les vues, les images et les orientations 
du patient. 
 
Supposons que vous définissiez deux vues comme suit : 
 
Vue A 

Rangée 
(Row) 

Colonne 
(Column) 

Vue de film 
(Film View) 

Orientation du patient  
(Patient Orientation) 

1 1 RCC PF 

1 2 LCC AF 

2 1 RLMO AFL 

2 2 LMLO PFL 

 
Vue B 

Rangée 
(Row) 

Colonne 
(Column) 

Vue de film 
(Film View) 

Orientation du patient 
(Patient Orientation) 

1 1 RCC FL 

1 2 LCC PF 

2 1 RLMO PFL 

2 2 LMLO FR 

 
Les orientations par défaut du patient sont affectées aux images placées dans 
les cellules. Supposons que la vue soit active. L'image placée sur la rangée 1, 
colonne 1 (RCC) aura l'orientation par défaut PF. 
 
Supposons que l'utilisateur effectue un clic droit sur l'image, remplace son 
orientation par PF, puis fasse glisser l'image dans la rangée 2, colonne 2 (LMLO). 
Cette image remplace la valeur d'orientation par défaut PFL et conserve 
l'orientation PF affectée par l'utilisateur. 
 
Supposons à présent que l'utilisateur sélectionne la vue B pour ce même examen. 
Cette action applique les valeurs par défaut d'orientation patient de la vue B aux 
images. L'image dans la vue de film RCC, par exemple, a maintenant une 
orientation patient FL. 
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Supposons que l'utilisateur ferme l'examen, et que vous (l'administrateur) modifiez 
ensuite la vue B, en remplaçant l'orientation du patient de la vue de film RCC par 
AF. Si l'examen est rouvert, l'image RCC a l'orientation patient FL (enregistrée 
avec l'examen lors de sa fermeture), et non AF (la nouvelle orientation AF par 
défaut pour RCC). Toutefois, si une nouvelle image est ajoutée à la cellule RCC, 
son orientation patient sera, par défaut, la valeur AF par défaut. 
 
Création de codes de vues personnalisées et de codes 
modificateurs de vues personnalisées 
 
Vous pouvez créer des codes de vues personnalisées qui apparaîtront dans la liste 
déroulante de la colonne Vue de film (Film View) de la liste Ordre des vues 
(View Order) dans la branche Local | Mammographie (Local | Mammography) de 
l'arborescence Administration (opération décrite précédemment dans cette section). 
Vous pouvez également créer des codes modificateurs de vues personnalisées 
associés avec les codes de vues personnalisées. 
 

Remarque - Lors de la publication de ce manuel, les codes 
de vues personnalisées et codes modificateurs de vues 
personnalisées n'étaient pas définis par la norme DICOM ou IHE. 
La responsabilité du développement, de l'utilisation et de la fiabilité 
des codes de vues personnalisées et codes modificateurs de vues 
incombe entièrement à l'utilisateur de ClinicalExpress. 

 
 Pour créer un code de vue personnalisée : 

1. Dans la branche Local | Mammographie (Local | Mammography) 
de l'arborescence Administration, cliquez sur le bouton Personnaliser 
(Customize). Ceci permet d'ouvrir la fenêtre Personnaliser les vues de 
mammographie (Customize Mammography Views), (cf. page suivante). 

2. Dans la section Codes de vues personnalisées (Custom View Codes), 
cliquez sur le bouton Nouveau (New). 

3. Cliquez dans chaque colonne, puis renseignez les informations qui s'y 
rattachent. 

4. Cliquez sur Enregistrer (Save). 
 

 Pour modifier un code de vue personnalisée : 
1. Dans la section Codes de vues personnalisées (Custom View Codes), 

cliquez sur le code de vue que vous souhaitez modifier. 
2. Cliquez sur Modifier (Edit). 
3. Modifiez les informations selon vos besoins. 
4. Cliquez sur Enregistrer (Save). 
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 Pour supprimer un code de vue personnalisée : cliquez sur le code de vue que 
vous voulez supprimer, puis cliquez sur Supprimer (Delete). 

 
Remarque - Un code de vue personnalisée peut être supprimé 
ou modifié uniquement s'il ne fait pas référence à une mise en 
page de vue. 

 
 Pour créer un code modificateur de vue personnalisée : 

1. Dans la section Code modificateur de vue personnalisée (Custom View 
Modifier Code), cliquez sur le bouton Nouveau (New). 

2. Cliquez dans chaque colonne, puis renseignez les informations qui s'y 
rattachent. 

3. Cliquez sur Enregistrer (Save). 
 

 Pour modifier un code modificateur de vue personnalisée : 
1. Dans la section Codes modificateurs de vues personnalisées (Custom 

View Modifier Codes), cliquez sur le code modificateur de vue que vous 
souhaitez modifier. 

2. Cliquez sur Modifier (Edit). 
3. Modifiez les informations selon vos besoins. 
4. Cliquez sur Enregistrer (Save). 
 

 Pour supprimer un code modificateur de vue personnalisée : cliquez sur le 
code modificateur de vue que vous voulez supprimer, puis cliquez sur 
Supprimer (Delete). 

 
Remarque - Un code modificateur de vue personnalisée peut 
être modifié ou supprimé uniquement s'il ne fait pas référence à 
un code de vue personnalisée. 

 
Remarque - Pendant le service DICOM Store et l'exportation, les 
codes de vues personnalisées sont ajoutés à l'en-tête de l'image 
DICOM de vue séquence de codes de vues (0054, 0222). Tous les 
codes modificateurs de vues sont envoyés sous la forme d'une 
séquence de codes modificateurs de vues (0054, 0220) qui fait 
partie d'une séquence de codes de vues. 
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Désignation de champs obligatoires de saisie de données 
 
Les champs de saisie de données figurant dans les fenêtres Informations sur le 
patient (Patient Information) et Informations sur l'examen (Study Information) 
peuvent être désignés comme obligatoires (indiqués par des noms de champs en 
caractères gras) conformément aux politiques de votre entreprise. 
 
Définissez des champs de données obligatoires dans la branche Local | Champs 
obligatoires (Local | Mandatory Fields) de l'arborescence Administration. 
 

 
 
 
1. Définissez des champs obligatoires selon vos besoins : 
 
 Pour demander à l'utilisateur de renseigner un champ : sélectionnez la 

case dans la colonne Obligatoire (Mandatory). 
 
 Pour rendre un champ facultatif : désélectionnez la case dans la colonne 

Obligatoire (Mandatory). 
 
2. Cliquez sur le bouton Appliquer (Apply). 
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Gestion de comptes utilisateurs 
 
L'écran Gestionnaire d'utilisateurs (User Manager) permet aux administrateurs de 
ClinicalExpress d'ajouter, de modifier et de supprimer des comptes d'utilisateurs. 
 

Remarque - Sous Windows 2000 ou Windows XP, des privilèges 
d'utilisateur expérimenté doivent être octroyés à tous les 
utilisateurs de ClinicalExpress. 

 
Ajoutez, modifiez ou supprimez des comptes utilisateurs dans l'écran  
Local | Gestionnaire d'utilisateurs (Local | User Manager) de la fenêtre 
Administration. Les instructions commencent à la page suivante. 
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 Pour ajouter un compte utilisateur : 
 

a. Cliquez sur le bouton Ajouter (Add). Ceci permet d'ouvrir la fenêtre 
Informations sur l'utilisateur (User Information) 

 

  
 
b. Pour le nouvel utilisateur, entrez le nom d'utilisateur (User name) (c'est-à-

dire, le nom utilisé pour la fenêtre de connexion), le Nom complet (Full 
Name) et la Description (p. ex., le nom de la tâche). Entrez un mot de 
passe (Password) pour l'utilisateur, puis entrez de nouveau le mot de passe 
dans Confirmer le mot de passe (Confirm Password). 

 
c. Cliquez sur Créer (Create). 
 
 

 Pour changer le nom complet d'un utilisateur, la description ou mot de passe : 
 
a. Dans la liste des utilisateurs (user list), cliquez dans la rangée 

correspondant au compte utilisateur. 
 
b. Cliquez sur le bouton Modifier (Edit). 
 

  
 
c. Modifiez les informations selon vos besoins. 
 
d. Cliquez sur Enregistrer (Save). 
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Remarque - Vous ne pouvez pas modifier le nom de connexion 
de l'utilisateur (Nom d'utilisateur [User Name]). Pour modifier 
un nom d'utilisateur, supprimez ce compte utilisateur et créez un 
nouveau compte utilisateur, comme décrit précédemment dans 
cette section. 

 
Remarque - Le mot de passe de l'administrateur peut être modifié, 
mais pas le nom d'utilisateur de l'administrateur. Conservez le mot 
de passe de l'administrateur à un emplacement sécurisé. 

 
 

 Pour supprimer un compte utilisateur : 
 
a. Dans la liste des utilisateurs (user list), cliquez dans la rangée 

correspondant au compte utilisateur. 
 
b. Cliquez sur le bouton Supprimer (Remove). 

 
Remarque - Le compte utilisateur « Admin » ne peut pas être 
supprimé. 

 
 
 
Les mots de passe ne peuvent pas être récupérés. Si un utilisateur oublie son mot 
de passe, vous devez supprimer son compte, puis lui créer un nouveau compte. 
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Sélection de champs de données pour l'anonymisation 
 
Pour préserver la confidentialité des données du patient, les données des champs 
sélectionnés peuvent être anonymisées (supprimées ou remplacées par des 
valeurs fixes) lorsque des examens sont envoyés vers une cible. Les données 
d'origine stockées dans la base de données ClinicalExpress ne sont pas changées 
lorsque l'anonymisation leur est appliquée pendant la transmission. 
 
La configuration de l'anonymisation des données comprend deux étapes : 
1. La désignation de champs à anonymiser, décrite dans cette section. 
2. L'activation de l'option Anonymiser (Anonymize) pour les cibles, décrite 

dans la section suivante de ce chapitre et intitulée « Définition de cibles ». 
 
Ajoutez, modifiez ou supprimez des champs anonymes dans l'écran  
Local | Anonymiser (Local | Anonymize) de la fenêtre Administration. 
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 Pour désigner un champ à anonymiser : 
 

a. Cliquez sur le bouton Ajouter (Add). Ceci permet d'ouvrir la fenêtre 
Informations sur l'élément anonymisant (Anonymizer Element 
Information) 

 

  
 
b. Ouvrez la liste intitulée Nom (Name), puis cliquez dans le champ à 

anonymiser. Vous pouvez anonymiser les champs suivants : 
 Nom du patient  

(Patient Name) 
 ID du patient (Patient ID) 
 Date de naissance  

(Birth Date) 
 Sexe du patient  

(Patient Sex) 
 Numéro d'enregistrement 

(Accession Number) 
 Date d'examen  

(Study Date) 
 Heure de l'examen  

(Study Time) 
 Description de l'examen 

(Study Description) 
 Description de la série 

(Series Description) 
 

 Description du diagnostic d'admission 
(Admitting Diagnosis Description) 

 Nom du médecin traitant  
(Referring Physician Name) 

 Nom de l'établissement (Institution Name) 
 Modalité (Modality) 
 Fabricant (Manufacturer) 
 ID de l'examen (Study ID) 
 Numéro de la série (Series Number) 
 Numéro d'instance (Instance Number) 
 Type de conversion (Conversion Type) 
 Partie du corps examinée  

(Body Part Examined) 

 
c. En option : entrez une valeur (Value) pour remplacer les données du 

patient. Si aucune valeur n'est saisie, le champ sera vide lors de son 
anonymisation. 

 
d. Cliquez sur OK. 
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 Pour modifier les valeurs d'anonymisation d'un champ : 
 

a. Cliquez sur la ligne du champ à modifier. 
 

b. Cliquez sur le bouton Modifier (Edit). 
 

c. Dans la fenêtre Informations sur l'élément anonymisant (Anonymizer 
Element Information), remplacez la Valeur (Value). 

 

d. Cliquez sur OK. 
 
 

 Pour supprimer l'anonymisation d'un champ : 
 

a. Cliquez sur la ligne à supprimer. 
 

b. Cliquez sur le bouton Supprimer (Remove). 
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Sauvegarde et restauration de la licence 
 
La sauvegarde de la licence est fournie pour les installations de ClinicalExpress. 
Cette fonction doit être configurée peu après l'installation de ClinicalExpress. 
Elle vous permet d'enregistrer la clé de licence à un emplacement sécurisé, p. ex. 
un répertoire sur le réseau ou un lecteur flash USB (clé USB), afin de pouvoir 
restaurer la licence en cas de problème logiciel ou matériel sur un ordinateur. 
 
Le fichier de sauvegarde de licence enregistre le nombre de numérisations 
restantes et la date d'expiration de la licence. Ce fichier est recréé toutes les 
24 heures avec la numérisation et les données de temps les plus récentes en 
remplaçant la copie précédente (c'est pourquoi, vous ne pouvez pas effectuer 
de sauvegarde sur un CD ou un DVD). Si ClinicalExpress n'est pas en cours 
d'exécution lorsqu'une sauvegarde est planifiée, la sauvegarde sera réalisée au 
prochain lancement de l'application. 
 

Sauvegarde de la licence 
 
Sauvegardez la licence dans l'écran Local | Sauvegarde de clé de licence 
(Local | License Backup) de la fenêtre Administration. 
 

 
 
 
 Pour sauvegarder la licence : 
 

a. Activez l'option Activer la sauvegarde de la licence (Enable License 
Backup). 

b. Cliquez sur le bouton Plus (More) , puis sélectionnez l'emplacement 
où vous souhaitez enregistrer la licence. 

 
Remarque - Ne sélectionnez pas un emplacement sur l'ordinateur 
local. Sélectionnez un emplacement, comme un répertoire sur le 
réseau ou un lecteur flash constamment inséré dans l'ordinateur, 
qui ne sera pas affecté si l'ordinateur local a un problème ou doit 
être remplacé. 

 
c. Cliquez sur le bouton Sauvegarder la licence (Backup License). 
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Restauration de la licence 
 
En cas de problème matériel ou logiciel sur l'ordinateur exécutant ClinicalExpress, et 
d'activation de l'option de sauvegarde de la licence (décrite à la page précédente), 
VIDAR peut restaurer votre licence. 
 
1. Rédigez un nouveau message électronique. 
 
2. Dans le champ À (To) du message, entrez l'adresse medtech@3dsystems.com. 
 
3. Localisez le fichier de sauvegarde de licence (il comportera l'extension .ref) et 

joignez-le au message. 
 
4. Dans le corps du message, décrivez la situation et demandez la restauration de 

votre licence. 
 
5. Envoyez le message. 
 
6. Lorsque vous recevez une réponse avec la licence restaurée, installez la licence 

comme décrit à l'étape 2 de la section « E. Obtention d'une clé de licence 
ClinicalExpress » du chapitre « Installation de ClinicalExpress » dans ce manuel. 

 
Si vous ne pouvez pas fournir une copie de votre licence, vous devrez en acheter 
une nouvelle. 
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Définition de cibles 
 
Les administrateurs peuvent configurer, modifier et supprimer des paramètres relatifs 
aux cibles et aux périphériques distants. Une cible correspond à une destination des 
examens et/ou à une source pour les données des listes de travail des modalités (les 
listes de travail des modalités peuvent être achetées séparément). 
 
Vous pouvez travailler avec les cibles dans la branche Cibles (Targets) de 
l'arborescence Administration. 
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Création d'une nouvelle cible 
 
1. Cliquez sur le bouton Nouveau (New). Ceci permet d'ouvrir la page Nouvelle 

cible (New Target). 
 

  
 
2. Dans la section Cible (Target) : 
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a. Entrez le Nom (Name) de la cible. Le nom doit être clair et court, p. ex. 
« Clinique » ou « Dr. Gale ». Choisissez des noms que les utilisateurs ne 
pourront pas confondre. 

 
Remarque - Une fois le nom entré et la cible enregistrée, le 
nom ne peut pas être modifié. Pour modifier le nom, vous devez 
supprimer la cible et en créer un nouveau. 

 
b. Sélectionnez le Type de cible. Les choix sont les suivants : 
 DICOM STORE 
 STORAGE COMMITMENT 
 MODALITY PERFORMED PROCEDURE STEP 
 DICOM PRINTER 
 POSTSCRIPT PRINTER 
 DICOM CD 
 MODALITY WORK LIST 
 DICOM PATIENT QUERY 

 
Remarque - Le champ Type contrôle les champs qui peuvent 
être modifiés dans l'ensemble des sections de gauche de la 
fenêtre Nouvelle cible (New Target), et contrôle les champs 
affichés dans la section de droite (Configuration). 

 
c. (Facultatif) Entrez une Description pour la cible. 
 
d. Pour désigner cette cible comme valeur par défaut : activez l'option 

Par défaut (Default). Les informations relatives à la cible par défaut 
apparaissent dans la section Cible (Target) de la fenêtre principale de 
ClinicalExpress au démarrage du programme, et lorsque l'utilisateur 
clique sur le bouton Cible par défaut (Default Target). 

 
Conseil - Si cette station de travail est destinée à envoyer des 
études à une seule cible, ou si une cible sera la destination la 
plupart du temps, définissez cette cible comme valeur par défaut. 

 
e. Pour anonymiser les données envoyées à cette cible : activez l'option 

Anonymiser (Anonymize). Champs sélectionnés pour l'anonymisation dans 
la fenêtre Local | Anonymiser (Local | Anonymize), (cf. section précédente 
intitulée « Sélection de champs de données pour l'anonymisation » dans ce 
chapitre). 

 
f. Pour permettre une compression de base sans perte de JPEG pour cette 

cible : activez Autoriser la compression sans perte (Allow Lossless 
Compression). 
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3. Dans la section Communication : 
 

  
 

a. Entrez le titre AE de la destination distante (Application Entity Title). 
Les titres AE sont sensibles à la casse. 

 
b. Entrez la taille de PDU (PDU Size) en octets (Protocol Data Unit, unité de 

données du protocole) de la cible. Elle indique la taille de bloc maximale 
que la cible peut recevoir de ClinicalExpress. 

 
Remarque - Le titre AE (AE Title) et la taille de PDU (PDU Size) 
sont normalement définis par le programme de réception. 

 
c. Entrez le délai d'attente de réponse (Response Timeout) en minutes. Il 

s'agit de la durée pendant laquelle ClinicalExpress va attendre une réponse 
après avoir envoyé une communication à la cible. Un trafic réseau dense 
ralentit le fonctionnement de ClinicalExpress. La valeur maximale est de 
5 minutes. Pour indiquer une temporisation illimitée, entrez la valeur 0. 

 
d. Entrez le numéro de port de l'application réceptrice (p. ex., 104, 4006). 
 
e. Entrez le nom d'hôte (Host Name) ou l'adresse IP de l'application réceptrice. 
 
f. Si l'accès à la cible se fait au moyen d'une connexion par ligne commutée, 

activez l'accès par ligne commutée (Dial-up), et entrez les informations 
requises. 
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4. La section Numériseur (Digitizer) vous permet de régler la profondeur de bits 
et la résolution par défaut, et de contrôler si les utilisateurs peuvent remplacer 
ces valeurs par défaut. La profondeur de bits (Bit Depth) par défaut est de 16 
et la résolution est de 570. Dans la section Numériseur (Digitizer) : 

 

  
 

a. Pour activer le format de film afin de définir la résolution : activez l'option 
Définir la résolution en fonction de la taille du film (Set Film Size Based 
Resolution). 

 
b. Pour changer la profondeur de bits et la résolution par défaut : activez 

l'option Activer la profondeur de bits et la résolution (Enable Bit Depth 
and Resolution), puis réglez la profondeur de bits (Bit Depth) et la 
résolution (Resolution) aux valeurs requises. (Les valeurs disponibles 
dépendent du numériseur raccordé.) 

 
c. Pour permettre aux utilisateurs de remplacer la profondeur de bits et la 

résolution par défaut : activez (ou laissez activée) l'option Activer la 
profondeur de bits et la résolution (Enable Bit Depth and Resolution). 
Points à examiner : 
 Désactivez l'option Activer la profondeur de bits et la résolution 

(Enable Bit Depth and Resolution) si la cible doit recevoir les images 
acquises à une profondeur de bits et à une résolution spécifiques. Il 
s'agit de la configuration recommandée si vous n'utilisez pas l'option 
Définir la résolution en fonction de la taille du film (Set Film Size 
Based Resolution). 

 Activez l'option Activer la profondeur de bits et la résolution (Enable 
Bit Depth and Resolution) si la cible peut recevoir les images acquises 
à n'importe quelles profondeur de bits et résolution, et si un ou plusieurs 
utilisateurs de ClinicalExpress sont formés à la sélection des paramètres 
appropriés pour l'examen et la cible. 

 
Remarque - Chaque établissement est tenu de s'assurer que la 
profondeur de bits et la résolution sont adaptées du point de vue 
clinique aux images et examens pour lesquels ClinicalExpress 
est utilisé. 
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5. Les options de la section Configuration dépendent du type de cible 
sélectionné. Suivez les instructions relatives au type de cible sélectionné : 

 
 
 Pour la cible de type DICOM STORE : 
 

  
 

a. Si une palette de couleurs est disponible pour la cible, activez l'option 
Palette de couleurs (LUT), puis cliquez sur le bouton ... (cf. flèche) 
pour sélectionner le fichier de la palette de couleurs. 

 
b. Si ClinicalExpress doit répondre aux messages d'engagement de 

stockage d'une cible : 
 Activez Engagement de stockage (Storage Commitment). 
 Sélectionnez une cible (Target), ou sélectionnez l'option Identique 

(Same) pour que cette option s'applique à la cible actuelle. 
 Entrez un délai d'attente maximum (Maximum Wait Time). 

ClinicalExpress ne lancera aucune opération, sauf s'il reçoit 
une confirmation d'engagement de stockage dans ce délai. 

 
 
 Pour la cible de type STORAGE COMMITMENT : 
 

  
 
 Entrez un délai d'attente maximum (Maximum Wait Time). 

ClinicalExpress ne lancera aucune opération, sauf s'il reçoit une 
confirmation d'engagement de stockage dans ce délai. 

 
 
 Pour la cible de type MODALITY PERFORMED PROCEDURE STEP, 

il n'y a aucune option de configuration. 
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 Pour la cible de type DICOM PRINTER : 
 

  
 

a. Si une palette de couleurs est disponible pour le reprographe, activez 
l'option Palette de couleurs (LUT), puis cliquez sur le bouton ... (cf. 
flèche) pour sélectionner le fichier de la palette de couleurs. Les palettes 
de couleurs disponibles se trouvent dans le répertoire spécifique du 
reprographe sur le CD d'installation de ClinicalExpress. 

 
b. Si une palette de couleurs n'est pas disponible pour le reprographe, activez 

l'option Appliquer les valeurs SDF (Standard Display Function), puis : 
 Définissez le type d'imprimante (Printer Type) correspondant au 

reprographe DICOM. 
 Réglez le type de transformation (Transformation Type) sur SCP (le 

reprographe applique la valeur SDF à l'image) ou SCU (ClinicalExpress 
applique la valeur SDF à l'image). Pour que le type de transformation 
(Transformation Type) soit valide, le reprographe DICOM doit prendre 
en charge la classe SOP de présentation de la palette de couleurs 
(reportez-vous au manuel du reprographe pour de plus amples détails) ; 
ceci sera traité par le logiciel pendant la phase d'association. 

 Si l'option Appliquer la valeur SDF à l'image même si elle n'est pas 
prise en charge par le reprographe (Apply SDF on image even if not 
supported by printer) est activée et si le reprographe ne prend pas en 
charge la classe SOP de présentation (reportez-vous au manuel du 
reprographe), ClinicalExpress génère les valeurs SDF (en fonction des 
champs Illumination et Lumière ambiante [Ambient Light]), et il 
applique une palette de couleurs à l'image avant de l'envoyer au 
reprographe. 
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 Entrez les valeurs d'illumination (luminance lumineuse provenant de 
l'éclairage) et de lumière ambiante (Ambient Light) (luminance 
lumineuse provenant de la lumière ambiante) à utiliser dans le calcul 
des valeurs SDF. Les valeurs DICOM par défaut sont : 

 Support transmissif 
(film) 

Support réfléchissant 
(papier) 

Illumination 2 000 cd/m2 150 cd/m2 

Lumière ambiante 10 cd/m2 0 cd/m2 

 
c. Dans la section Paramètres (Settings) : 
 Réglez le grossissement selon vos besoins. Les options sont les 

suivantes : 
 Reproduire (Replicate) (chaque pixel du reprographe représente 

un pixel d'image). 
 Aucun (adapte l'image à la taille moyenne d'un reprographe sans 

rééchantillonnage). 
 Bilinéaire (adapte l'image à la taille moyenne d'un reprographe en 

utilisant un rééchantillonnage bilinéaire). 
 Cubique (adapte l'image à la taille moyenne d'un reprographe en 

utilisant un rééchantillonnage cubique). 
 Règle l'orientation du film sur Portrait (le bord long est à la verticale) 

ou sur Paysage (Landscape) (le bord long est à l'horizontale). 
 Sélectionnez le support de la cible : film bleu (Blue Film), Film 

transparent (Clear Film) ou Papier (Paper). 
 Définissez la taille du film en pouces. 
 Définissez les valeurs de DMin (minimum film opacity, opacité 

minimale du film) et DMax (maximum film opacity, opacité maximale 
du film). 

 Activez la taille réelle (True Size) pour imprimer le format d'affichage 
exact du cliché d'origine. Si cette option n'est pas activée, le format 
d'affichage de l'image sera modifié pour l'adapter à la zone imprimable. 

 Zone imprimable (Printable Area) indique la zone imprimable qui 
sera utilisée pour recadrer l'image, si le format d'image requis est de 
taille supérieure à la zone imprimable du reprographe. 
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Plus d'informations sur la zone imprimable 

Une reproduction de film a généralement une zone imprimée inférieure à celle du cliché d'origine de la 
même taille globale.  

 Lors de l'impression d'une image sur un support de la même taille que le cliché d'origine, vous pouvez 
vous attendre à ce qu'une diminution ou un recadrage se produise (en fonction des paramètres définis 
dans la section Configuration de la cible DICOM PRINTER et des options rendues disponibles par le 
serveur et le reprographe). 

 En cas d'impression d'une image de taille inférieure à celle de la zone imprimable du reprographe (qui 
est généralement de 14 x 17 po), l'image obtenue est de la même taille que l'original. 

Exemple : supposons que la zone imprimable est de 13,5 x 16,5 po et que la résolution est de 150 pixels 
par pouce. Les valeurs de la zone imprimable seraient 

14X17 : 2025,2475 

où 14X17 : correspond à la taille de cliché d'origine (doit inclure « X » en majuscules) 

      2025 correspond à la largeur imprimable en pixels (13,5 pouces x 150 pixels par pouce) 

      2475 correspond à la longueur imprimable en pixels (16,5 pouces x 150 pixels par pouce) 
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 Pour la cible de type POSTSCRIPT PRINTER : 
 

  
 

a. Si une palette de couleurs est disponible pour la cible, activez l'option 
Palette de couleurs (LUT), puis cliquez sur le bouton ... (cf. flèche) 
pour sélectionner le fichier de la palette de couleurs. Les palettes 
de couleurs disponibles se trouvent dans le répertoire spécifique 
du reprographe sur le CD d'installation de ClinicalExpress. 

 
b. Cliquez sur Paramètres (Settings) pour ouvrir la fenêtre standard 

Configuration de l'impression (Print Setup). Dans cette fenêtre, 
vous pouvez sélectionner un reprographe et modifier ses propriétés. 

 
Remarque - Des pilotes d'imprimante Postscript doivent être 
installés pour prendre en charge ce type de cible. Reportez-
vous au manuel du reprographe pour obtenir des informations 
sur les pilotes. 

 
 
 Pour la cible de type DICOM CD : 
 

  
 

a. Définissez le nombre de copies à créer. 
 
b. Sélectionnez le lecteur de CD-ROM. 
 
 

 Pour la cible de type MODALITY WORK LIST : 
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a. Activez Utiliser uniquement les informations sur le patient (Use 

Only Patient Information) pour importer uniquement les informations 
patient de base à partir d'une requête de liste de travail des modalités. 

 
b. Activez Activer une requête large (Enable Broad Query) si le système 

peut accéder à plusieurs listes de travail des modalités, et si vous 
souhaitez que l'utilisateur soit en mesure d'effectuer une recherche sur 
toutes les listes de travail des modalités à l'aide d'une requête unique. 

 
c. Activez Date de début d'étape de procédure planifiée pour date 

d'examen (Scheduled Procedure Step Start Date to Study Date) pour 
faire correspondre la date de la procédure avec la date de l'examen lors 
de la création d'un nouveau compte patient en interrogeant le serveur de 
liste de travail des modalités. 

 
d. Activez ID de procédure requis pour ID d'examen (Requested 

Procedure ID to Study ID) pour faire correspondre un ID de procédure 
requis avec un ID d'examen. 

 
 
 Pour la cible de type DICOM PATIENT QUERY, il n'y a aucune option de 

configuration. 
 
 
6. Lorsque toutes les informations sur la cible ont été saisies, cliquez sur le 

bouton Enregistrer (Save). La nouvelle cible apparaît dans la branche 
Cibles (Targets) de l'arborescence Administration. 

 
 
 



 

19743-001 Rév. E Guide de l'administrateur de ClinicalExpress 6.1 

Gestion des informations sur les cibles 
 
 
 Pour afficher la liste des cibles existantes : cliquez sur Cibles (Targets) dans 

l'arborescence Administration. 
 

 
 
 
 Pour afficher les paramètres d'une cible : cliquez sur le nom de la cible en 

dessous de Cibles (Targets) dans l'arborescence Administration. 
 
 
 Pour afficher les informations sur une cible : 

 
a. Cliquez sur le nom de la cible en dessous de Cibles (Targets) dans 

l'arborescence Administration. 
  ou 
 Cliquez sur le nom de la cible dans la liste récapitulative des cibles. 
 
b. Cliquez sur le bouton Modifier (Edit). Les champs deviennent actifs et 

peuvent être modifiés. 
 
c. Lorsque vous avez terminé, cliquez sur le bouton Enregistrer (Save). 

 
 
 Pour supprimer une cible : 

 
a. Cliquez sur le nom de la cible en dessous de Cibles (Targets) dans 

l'arborescence Administration. 
  ou 
 Cliquez sur le nom de la cible dans la liste récapitulative des cibles. 
 
b. Cliquez sur le bouton Supprimer (Delete). 
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Vérification de la communication 
 
Lorsque la cible est définie, il est recommandé de tester la communication entre 
ClinicalExpress et la cible ou l'administrateur de liste de travail des modalités 
(la fonctionnalité de liste de travail des modalités de ClinicalExpress peut être 
achetée séparément). Vous pouvez bien sûr effectuer le test à un autre moment. 
 
1. Dans la fenêtre principale de ClinicalExpress, Fichier > Générer un motif de 

test > SMPTE (File > Generate Test Pattern > SMPTE). Cette fonction utilise 
un examen acquis spécialement qui existe strictement à des fins de test. 

 
2. Ouvrez la liste de cibles (Targets) et cliquez sur la cible à tester. 
 
3. Dans l'écran Cibles (Targets), cliquez sur le bouton Vérifier (Verify) 

(juste au-dessous de la liste déroulante des cibles). 
 
4. Attendez que ClinicalExpress réponde. L'un des deux messages 

suivants s'affiche : 
 
 Le message « Cible - [nom de cible]. La demande de vérification a réussi. » 

(Target – [target name]. Verification request succeeded.) indique que la cible 
a répondu avec succès à la commande DICOM Echo de ClinicalExpress. 

 
 Le message « Cible - [nom de cible]. La demande de vérification a 

échoué. » (Target – [target name]. Verification request failed.) indique que 
la cible n'a pas répondu à la commande Echo. Si vous voyez ce message, 
vérifiez la configuration de la cible en détails dans ClinicalExpress, puis 
assurez-vous que le réseau fonctionne correctement. 

 
 
 

Examen de la configuration du numériseur de films 
 
Vous pouvez afficher la configuration du numériseur dans la branche 
Numériseur (Digitizer) de l'arborescence Administration. 
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Vérification de la disponibilité de la liste de travail des 
modalités 

 
Remarque - L'option Liste de travail des modalités (Modality 
Work List) de ClinicalExpress peut être achetée séparément. 
Votre licence ClinicalExpress doit comprendre la liste de travail 
des modalités pour que cette fonction soit disponible. 

 
Remarque - Les instructions de cette section supposent que 
l'administrateur a fini de lire les instructions relatives à la création 
d'une nouvelle cible de liste de travail des modalités (reportez-vous 
à la section « Définition de cibles » précédemment dans ce 
chapitre). 

 
 Pour déterminer si l'option Liste de travail des modalités (Modality Work List) 

est installée : 
 

a. Dans la fenêtre principale, Affichage > Examens acquis (View > Acquired 
Studies). 

 
b. Dans la fenêtre Informations sur l'examen (Studies Information), vérifiez 

la liste de cibles (Targets). 
 La présence d'au moins une cible dans la liste signifie que l'option Liste 

de travail des modalités (Modality Work List) est installée et a déjà été 
configurée pour une cible de liste de travail des modalités. 

 Si la liste est vide, cela signifie que l'option Liste de travail des modalités 
(Modality Work List) n'est pas installée : 

 
c. Dans la fenêtre Informations sur l'examen (Studies Information), cliquez 

sur Fermer (Close). 
 
 Pour vérifier que la station de travail ClinicalExpress est connectée à une 

source de liste de travail des modalités : 
 

a. Dans la fenêtre principale, ouvrez la liste de cibles (Targets), puis cliquez 
sur une cible de la liste de travail des modalités. 

 

  
 
b. Cliquez sur Vérifier (Verify). 
 
c. Un message vous indiquera si la connexion fonctionne. 

 
Remarque - Pour des instructions complètes sur l'utilisation 
de la liste de travail des modalités, reportez-vous à la section 
« Importation de données patient à l'aide de la liste de travail des 
modalités » dans le « Guide de l'opérateur ClinicalExpress ». 
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Examen et gestion du fichier journal 
 
Le fichier journal, un fichier texte stocké dans le répertoire du programme, 
contient un enregistrement des actions exécutées par ClinicalExpress. Utilisez 
le fichier journal pour examiner et analyser les activités de l'utilisateur et du 
programme à des fins de dépannage. ClinicalExpress fournit une fenêtre pour 
l'affichage et la gestion du fichier journal. 
 
 

 
 
 
 Pour afficher le fichier journal : Affichage > Fichier journal (View > Log File). 
 
 Pour supprimer les données du fichier journal : cliquez sur le bouton Effacer 

le journal (Clear Log). 
 
 Pour lire de nouvelles données dans le fichier journal : cliquez sur le bouton 

Actualiser (Refresh). 
 
 

Remarque - Définissez les options du journal dans la branche 
Local de la page Administration (reportez-vous à « Journal » 
dans la section « Réglage des paramètres de la station de 
travail locale » précédemment dans ce chapitre). 
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Étalonnage du numériseur de films 
 
Étalonnez le numériseur de films comme recommandé dans le manuel 
d'utilisation du numériseur de films. 
 

Remarque - L'étalonnage prendra plusieurs minutes, durant 
lesquelles vous ne serez pas en mesure d'utiliser le numériseur 
ou ClinicalExpress. 

 
 Pour étalonner le numériseur : 
 

a. Options > Étalonner le scanner (Options > Calibrate Scanner). 
 
b. Confirmez que vous voulez lancer un étalonnage. 
 

  
 
c. Attendez pendant l'étalonnage du numériseur de films. 
 

  
 
d. Lorsque l'étalonnage est terminé, cliquez sur Oui (Yes). 
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Étalonnage de votre écran 
 
Une bonne qualité de l'image dépend de la sortie d'affichage. Lorsque votre écran 
représente une image avec précision, vous pouvez évaluer efficacement la qualité 
de l'image et optimiser l'image avec succès. Même si le film a été correctement 
numérisé, l'image peut sembler être de mauvaise qualité sur un écran non étalonné. 
Cette section présente deux méthodes simples d'étalonnage d'écran. 
 
Signalez tous problèmes d'affichage au physicien médical chargé du CQ de 
l'affichage. Il convient d'étudier les problèmes d'affichage au moyen d'évaluations 
approfondies suivies d'un réajustement, d'un entretien, de réparations ou du 
remplacement de l'appareil. 
 
Pour un étalonnage plus rigoureux de l'affichage, VIDAR recommande les produits 
VeriLUM disponibles auprès de : 
 
 IMAGE Smiths, Inc. 
 P.O. Box 30928 
 Bethesda, MD 20824, États-Unis 
 
 Tél. :     +1 (240) 395 1600 
 Site Web : www.image-smiths.com 
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Étalonnage avec le motif de test SMPTE 
 
1. Fichier > Générer un motif de test > SMPTE (File > Generate Test Pattern > 

SMPTE) pour ouvrir le motif SMPTE (illustré ci-dessous). 
 
2. Baissez les commandes de contraste et de luminosité de l'écran. 
 
3. Augmentez la luminosité jusqu'à l'apparition des barres dans les coins. 
 
4. Augmentez le contraste jusqu'à environ 80 % ou plus jusqu'à ce que les carrés de 

0 %/5 % et de 95 %/100 % apparaissent aussi clairement que possible sur l'image. 
 
 

 
 

carré de 0 %/5 %  carré de 95 %/100 % 
 
 
 

Remarque - Si vous visualisez une copie électronique de ce 
document sur un écran et ne voyez ni carré de 0 %/5 % ni carré 
de 95 %/100 % sur cette page (indiqué par les flèches), ceci 
signifie que votre écran doit être étalonné. 
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Étalonnage avec le motif de test TG18-QG 
 
1. Fichier > Générer un motif de test > TG18-QC (File > Generate Test Pattern > 

TG18-QC) pour ouvrir le motif TG18-QC (illustré ci-dessous). 
 

 
 
 
2. Inspectez visuellement les caractéristiques suivantes : 
 

a. Distorsion géométrique : vérifiez que les bordures et les lignes du motif 
sont visibles et droites, et que le motif est centré au sein de la zone active 
du dispositif d'affichage. 

 
b. Qualité d'image générale et artefacts : évaluez l'aspect global du motif. 

Notez toute absence d'uniformité ou artefacts, en particulier au niveau 
des transitions noir-blanc et blanc-noir. Vérifiez que les zones de la rampe 
apparaissent en continu sans artefacts de contour. 
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c. Luminance lumineuse, réflexion et bruit : assurez-vous que les 16 patchs 
lumineux sont bien visibles. Assurez-vous que les patchs de 5 % et 95 % 
sont bien visibles. Évaluez l'aspect des lettres à faible contraste et 
confirmez la visibilité des cibles dans les coins des patchs lumineux. 

 
d. Résolution : évaluez l'aspect des cibles Cx au centre et dans les coins du 

motif et évaluez-les par rapport à la référence. Les scores doivent être  
< 5 pour les affichages primaires et < 7 pour les secondaires. Vérifiez 
également la visibilité des motifs à paires de lignes à la fréquence de 
Nyquist au centre et dans les coins du motif.* 

 
 
 
 
 
 
 
 
 

Contactez l'assistance technique de VIDAR si vous avez des 
questions sur la configuration du logiciel ClinicalExpress : 

Téléphone : +1.800.471.SCAN (+1.800.471.7226) 

                    +1.703.471.7070 en dehors des États-Unis 

E-mail :        medtech@3dsystems.com 

 
 

                                                      
* Étapes 2a à 2d réimprimées avec l'autorisation de « New Developments in Display 
Quality Control », par Ehsan Samei, dans Quality Assurance and Quality Control in the 
Digital Imaging Department, Eds. E. Siegel, B. Reiner, J. Carrino, SCAR Premier Series, 
Society for Computer Applications in Radiology, Great Falls, VA, 2002, pp. 71-82. 
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